
	               


    

    
            
            
                                                

    
        
            
          		          			
                        




                    
          		       
            
                       
            
                                
  	
  	  	



            

            
                
                    
                         
                         
                                                                                   
                                                    
                            0                            
                                Compare                            
                            

                                                                        
                    
                     
                
  
            
                        
        

    



  

  
     
	        
        	Comparison Charts
	Antivirus Comparison Chart 2024
	PC/MAC Tuneup Comparison Chart 2024
	VPN Comparison Chart 2024
	Web Hostings Comparison Chart 2024



	Reviews
	Accounting Software
	Antivirus
	Antimalware
	Backup
	Data Recovery
	Download Tools
	Disk Management
	File Compression
	Freelancers
	HDR Software
	Hosting Services
	Identity Protection
	Media Player
	Password Managers
	PDF Reader
	PC/MAC Optimization
	Speech Recognition
	Virtualization
	Video Editing
	VPN



	Blog
	Stores

        
            
                
                    
                        
                            
                            
                            
                        
                    
                
                
                    

                

            

                    

        
            
  	
  	  	



            
        

    




            
  
        
            

    

    
        
         
                       
                                                        
                        
                        
                            
                                Home » Reviews » PDF Reader » iTop PDF Review
 
                                PDF Reader
                        
                                iTop PDF Review
                                                           
                                
                                    					
														
						



					
						
								
															
							George Miller			
						
																
				 							 				 March 4, 2024				 									

										
			

			
														216 Views
					
							
					0	
							
			

			
	 
                                

                                
 
                                                                    
                                        	
	    SaveSavedRemoved 0 


	

                                    

                                    
 
                                   
                                                           
                            

                        

                        Add to compare

                         
                                                        
                        
                        iTop PDF Review 2024 – A Powerful and Easy-to-Use Tool for Annotating, Converting and Protecting PDF Files 

iTop PDF offers a wide range of editing tools that enable you to edit and update PDF files smoothly. With this intuitive PDF software, you can modify any content with ease. In addition to editing texts, images, and links, you can annotate, draw, highlight, move, or remove objects with the help of iTop PDF.
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Pros & Cons

PROS:

	Free version available
	Affordable VIP Plans
	East to use
	Powerful compressor and converter tools
	E-signature and watermark removal





CONS:

	Works only on Windows devices
	Free version limits file size and conversion
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What’s New in the Latest Version of iTop PDF and Comparison with the Previous Version








The latest version of iTop PDF boasts an improved UI that is more intuitive than before and enables you to use the app more efficiently. The various features of the app like the PDF Viewer, PDF Converter, and PDF Editor have undergone performance enhancement making them faster and more powerful than the earlier versions.

iTop PDF now supports over 30 languages that you can change by accessing the General Settings tab via the Menu options at the top left of the app.

While not many new tools or functionalities have been added to the latest version of iTop PDF, the existing features have seen major improvements in terms of usability, functionality, and efficiency.

The app does a great job of arranging the most important tools and features in a way that allows fast and easy access to the tools and features.

Finally, the latest version comes with several minor bug fixes courtesy of iTop’s committed engineers.
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iTop PDF Features Table


	
Features

	
Status


	PDF Viewer	




	PDF E-Signature	




	PDF Form Filler	




	PDF Compressor	




	OCR Converter	




	Password Protection	




	Watermark Removal	




	Supported Devices	
Windows 7, 8, 10, and 11


	Customer Service	
24/7 support, online contact form, user manual, and FAQs


	Price	
$11.99 per month for 1 month

$7.17 per month for 6 months

$4.17 per month for 1 year
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Features Overview







The PDF Viewer allows you to read PDF content and ebooks conveniently. It even allows you to easily add bookmarks and comments to your PDF content. iTop PDF also lets you arrange, crop, insert, and rotate pages as well as change page sequences with merely a few clicks. You can now digitally sign PDF files quickly by creating your E-signature with the help of iTop PDF. The PDF tool can instantly recognize forms and help you quickly fill web forms via the PDF Form Filler.

iTop PDF’s compressor can substantially reduce the size of PDF files without losing their quality. Upload all the PDF files you want to compress and simply click “compress” to allow iTop PDF to do its job. You can select the compression level from “smallest size with good quality” and “medium size with the best quality”.

iTop PDF allows you to merge multiple PDF pages into a single PDF for convenience. You can add, delete, and rearrange the individual pages before merging them into one PDF. You can even split one PDF file into multiple new PDF files or pages if the need arises. iTop VPN also lets you extract select pages from the original PDF and compose a new PDF file with the selected pages.

The fast and powerful converter of iTop PDF accurately converts PDFs to and from various other formats, including Excel, Word, and PPT while maintaining high quality. Furthermore, the OCR engine lets you identify and extract texts from images and scanned PDFs. With the iTop PDF, you can now quickly convert PDF to Word and vice-versa with accurate formatting as well as convert images and scanned PDFs to text via OCR (Optical Character Recognition).

iTop PDF can protect PDFs in many different ways for private and confidential use. I found it really helpful to encrypt PDF files with a password in case of a data breach. You can also search and select the text or image in a PDF, then redact them to make the sensitive data invisible. Plus, you can add a watermark to PDF files to quickly protect valuable copyrighted content.
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How-to Use Guide / My Personal Experience








iTop PDF cleverly organizes a variety of features in a clean interface that makes all the major tools quickly and easily accessible. With a ribbon-style toolbar popularized by Microsoft Office, the intuitive UI offers a user-friendly experience when reading and editing PDF documents.

Once you install and launch the iTop PDF app, you will see the app’s main screen that allows quick access to various tools of the app, including the converter, editor, and compressor, among others. You can also get a glance at the recent history of files at the bottom of the page. The top toolbar houses the Start, View, Convert, Edit, Comment, Protect, Pages, and Tools options. The Start tab is the main screen where you can open a PDF, quickly access tools, and view your most recent files.

The View tab lets you view PDF documents and adjust various parameters such as page size and layout to improve the readability of the documents. You can access the various viewing tools from the page navigation panel just under the View tab. Use the search option to quickly locate content in your files and “capture” any interesting content for future reference. The left navigation panel lets you access the Thumbnails, Bookmarks, Comments, and Attachments tabs. You can choose between three read modes, namely Light Mode, Dark Mode, and Eye-Care Mode.

Navigate to the Converter tab when you want to convert files. Just under the Converter tab, you will see a banner with the various formats from and to which you can convert your files. Once the converter window pops up, you can select the files for conversion as well as change the format to which you want to convert them. iTop PDF lets you convert PDF files to Word, Image, Text, Excel, and PPT as well as Office, Image, and other files to PDF. You can add more than one file and choose where on your computer you want to save the converted files. With a VIP license, you can even remove watermarks from the files you are converting. Furthermore, the free version allows you to convert only two files per day and limits the file size to 10 MB per file. When you pay for the VIP version, you can enjoy unlimited file conversion, unlimited file size, powerful compression, and access to all stamps.

The Edit and Comment tabs are self-explanatory and you can easily learn how to use these two sections by simply exploring them. While the former lets you edit content, add texts, add images, crop pages, edit watermarks, add links, and add bookmarks, the latter lets you add and edit comments, attachments, and stamps to your PDF documents. You can even change text color, highlight texts, and hide comments. Explore the tools on these tabs to find out more about the various utilities.

You can protect your PDF documents by encrypting them with a password. The Protect tab lets you encrypt and decrypt PDF documents with a few clicks. Use the Redaction tool to black out sensitive information or content. Click “Select for Redaction” to select the text you want to redact and then click “Apply Redaction” to redact the selected text. You can also sign PDF with your e-signature from the Signature feature under the Protect tab. The Signature feature even allows you to create a new signature by typing or drawing a signature.

The Pages tab is the organization center of the app and it lets you manipulate pages with the help of extracting, inserting, replacing, and cropping tools. This tab also lets you combine, compress, and split PDF files with a few clicks. You can select how to split pages, the compression level, and where to save your edited files. The Tools tab is the final tab and it offers access to the most commonly used features of iTop VPN, including the converter, editor, and signature tools, to name a few.

Finally, you can add new PDFs, open files, save files, and access the settings option from the Menu icon at the top left corner of the app. The Settings tab is divided into General Options, Update Options, and Notifications. From the General Options, you can select the language of the app and set iTop PDF as your default PDF reader. You can set the app to update automatically to the latest version or notify you when updates are available. The Notifications tab lets you set your notification preferences.

Refer to this iTop PDF user manual if you need further assistance with iTop PDF, which I doubt you will as I found the user interface user friendly and intuitive to use.
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Google Trends & Competitors


Google Trends is an analytical website that shows the relative interest in certain keywords based on Google Search volumes. I used Google Trends to study the interest in “iTop PDF”, “Xodo PDF Reader & Editor”, and “MuPDF” within the USA.







Interest in “iTop PDF” over the past 12 months has been inconsistent and had only peaked once near the end of 2022. Other than the surges in interest in the second half of the year, the interest in the search term has been average. Thanks to the extensive utility of Adobe’s suite of software tools, including its PDF reader, it is not surprising to see a low interest in PDF tools. Nonetheless, the average yet not unsubstantial interest in “iTop PDF” indicates users are still looking for alternatives to the big players in the PDF market.







iTop PDF’s popularity among users again comes to light when comparing it with competing software tools like “Xodo PDF Reader & Editor” and “MuPDF”. While the Google Trends graphs for these search terms show similarly inconsistent interest throughout the past 12 months, the average interest in iTop PDF and MuPDF was greater than that in Xodo PDF. Xodo PDF and iTop PDF both provide similar basic utilities but users are likely more interested in the latter thanks to a handful of extra features and nifty tools that it provides.

back to menu ↑
User Feedback

Feedback from social media users on Facebook and Twitter, among other social platforms, and software experts on tech forums are influential in determining the choices of consumers.

To understand what users think of iTop PDF, I explored several social media sites, tech forums, and Reddit. While there was a lack of plausible ratings and comprehensive reviews, I noticed that users on Reddit and tech forums were discussing about not only the features of the PDF tool but also the various ways it can be improved. The fact that users are talking about possible improvements to the app signifies that they are using or have used iTop VPN and are likely to keep using it.

I also checked consumer review websites like Sitejabber and Trustpilot for reviews from real users. While there were no reviews of iTop PDF, iTop VPN earned an enviable TrustScore of 4.3 out of 5 from over 260 reviews on Trustpilot. Nearly 80% of the reviewers rated the software and its parent company as excellent with many reviewers claiming to be very satisfied with their purchase. Though reviews of iTop VPN do not offer any insight into iTop PDF’s performance, the positive reviews of the parent company show that iTop is a reliable company that offers efficient tools and takes care of its customers.

back to menu ↑
Conclusion

iTop PDF is a full-featured PDF tool that allows the user to edit, view, and convert PDF files with ease. The tool also enables users to combine, compress, convert, organize, and even encrypt their PDF files from just one application. With a modern UI that is well-designed and simple to navigate, the free PDF tool is currently one of the best in the market for editing PDF files. You can purchase the VIP version of iTop PDF for an affordable price if you want access to all the features of the app. iTop PDF is a lightweight application that offers fast processing through powerful tools to achieve higher efficiency.
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			SoftoCoupon is a place where you can check online side-by-side software, services and tools features comparison. Our team of independent experts has more than 10 years of experience in writing professional in-depth reviews. The deep software analysis is our passion and we are trying to present our creation in plain English so everyone can learn something useful.
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